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application meets with your specifications. No representation or warranty is given and no liability is
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* Raspberry Pi is a trademark of the Raspberry Pi Foundation.
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1. BOARD LAYOUT AND FUNCTION
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Figure 1: MAKER-UNO-RP2040 Board Functions (TOP)

Function Description
e JST-PH 2-pin connector for LiPo / Li-lon battery.
. . e Connect to single cell LiPo / Li-lon battery. The battery is

LiPo / Li-Ion rechargeable via USB.

Battery ) )

Connector * The battery is protected from overcharged and over discharged. If the
board cannot be turned on when the battery is connected, please
charge the battery to activate the battery protection circuit.

On/Off Switch e Slide switch used to turn on or off the power.

. e LED Indicator for the LiPo/Li-lon battery charging status.
Charging LED e Turns on when the battery is charging and off when the battery is full
USB Type-C e Used for both powering and programming the board from a PC.
e Button used to reset the RP2040.

Reset Button e Press to restart the board without unplugging the USB cable or

battery.
e Button used to enter bootloader mode.
e Press and hold this button while resetting the Maker Uno RP2040 to

Boot Button enter bootloader mode. This mode is used to load either the
Micropython/Circuitpython firmware or custom C/C++ firmware
onto the device."
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Function

Description
User .

e Accessible from the user program.
Programmable

e Internally connected to GP2.
Button

Grove Ports

4-pin, 2.0mm pitch, Grove connector for external grove modules.
Pins connection;
Grove Port | GPIO | PWM SPI I12C | UART | Analog
1 0 PWMO0-A | SDIO | SDAO TXO0
1 PWMO0-B | CSn0O | SCLO RX0
4 PWM2-A | SDIO | SDAO TX1
2 5 PWM2-B | CSnO | SCLO RX1
6 PWM3-A | SCKO | SDA1 - -
3 26 PWM5-A | SCK1 | SDA1 - ADCO
7 PWM3-B | SDOO | SCL1
4 27 PWM5-B | SDO1 | SCL1 - ADC1
28 PWM6-A | SDI1 | SDAO TXO0 ADC2
> 29 PWM6-B | CSnl | SCLO RX0 ADC3
20 PWM2-A | SDIO | SDAO TX1
6 21 PWM2-B | CSnO | SCLO RX1

e |ST-SH 4-pin Connector for external modules or sensors.
Maker Port e Compatible with QWIIC / Stemma QT / Grove (with conversion
cable).
* The pins are shared with the Grove 6 port (GPIO 20, 21).
Pin Header e Female connector for external connection.

Servo Ports

Connectors for 4 x RC servo motors.

Signal (S) is internally connected to GP14, GP15, GP16 and GP17
respectively.

Servo Voltage is equal to the power source voltage.

SPI Port e Male header for SPI communication.
RGB LEDs e User programmable WS2812B RGB LED.
(WS2812) e Internally connected to GP25.
e LED indicators for RP2040 GPIOs that are connected to the socket
GPIO Status LEDs header.
e Turns on when the GPIO state is high.
Power LEDS e LED indicator for 3.3V and 5V.
e Turn on when powered up.
e Slide switch used to mute the piezo buzzer (placed at the bottom
Buzzer Mute
Switch layer of the PCB).
e Suggested to use if GP8 is used for other purposes.

Table 1: MAKER-UNO-RP2040 Board Functions
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Figure 2: MAKER-UNO-RP2040 Board Functions (Bottom)
Function Description
e Microcontroller for the Maker Uno RP2040 board.
Raspberry Pi e Low-cost, high-performance microcontroller equipped with a
RP2040 dual-core ARM Cortex-M0+ processor, ample memory, and
versatile I/0 options.
Piezo Buzzer e Programmable piezo buzzer, can be used to play tone or melody.
e Internally connected to GP8.
e Default closed solder jumper that connects 3.3V with 10s LED
Digital 10 LEDs power trace.
Disable Solder (e Cut (open) the connecting trace to disable the digital IO LEDs.
Jumper e This action can help to conserve power or reduce distraction from
the 10 LEDs.

Table 2: MAKER-UNO-RP2040 Board Functions (Bottom)
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2. PWM ON RP2040

The RP2040 PWM block is composed of 8 slices (PWMO0, PWM1, PWMZ2...), each having the
capability to drive two PWM output signals, A and B resulting in a total of up to 16 controllable
PWM outputs. Each GPIO pin is assigned with a PWM slice and output, which is also referred to
as a channel. Therefore, all RP2040 GPIO pins support PWM. However, if the GPIO pins share the
same PWM channel, simultaneous PWM usage is not possible.

Note that for the Maker Uno RP2040 not all GPIO pins of the RP2040 are broken out and
connected, the table below highlights potential channel conflicts that may occur. Please refer to
the pinout diagram in the next section for detailed information about each pin's PWM channel.

PWM Channel GPIO
0
PWMO0-A
16 (Servo 3)
1
PWMO-B
17 (Servo 4)
4
PWM2-A
20
5
PWM2-A
21

Table 3: Shared PWM channel for connected GPIO pins.

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 4



Simplifying Digital Making
Datasheet - MAKER-UNO-RP2040

3. PINOUT DIAGRAM
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4. SPECIFICATION
No Parameters Min | Max | Unit
1 | Power Input Voltage (USB or LiPo/Li-Ion) 3.6 6 \Y
Low Level -0.3 0.8 \Y
2 | Digital Input Voltage
High Level 2.0 3.6 Vv
Low Level 0 0.5 \Y%
3 | Digital Output Voltage
High Level 2.62 | 33 \Y
4 | Analog Input Voltage 0 3.3 \Y
5 | Total +3V3 Output Current - 500 | mA
6 | Total +5V Output Current - 600 | mA
7 | Vservo (Only USB is connected) VUSB - 0.4 \Y
8 | Vservo (Only LiPo/Li-Ion is connected) *VBAT \Y
9 [ Vservo (USB and LiPo/Li-Ion are connected) VUSB - 0.4 \Y
10 | Operating Temperature -20 85 C
11 | UsBVID & PID VD 0xZE8A
(CircuitPython & Arduino Core) PID 0x1071 c

Table 4: MAKER-UNO-RP2040 Absolute Maximum Ratings

*VBAT is the voltage of the LiPo/Li-Ion battery.
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Figure 4: MAKER-UNO-RP2040 Dimension
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6. SETTING UP FOR ARDUINO IDE, CIRCUITPYTHON OR MICROPYTHON

In this guide, we will walk you through setting up your Maker Uno RP2040 for three different
programming platform; CircuitPython, Arduino IDE and MicroPython. We'll then test each setup
with a simple blink code to ensure everything is working correctly.

Prerequisites:
e Maker Uno RP2040
e USB-C cable
e Computer with a USB port
o (Corresponding IDEs/coding softwares for each coding platform.

ARDUINO IDE

For this guide, it is written based on Arduino IDE version 2.

Before starting programming the board you will need to add the Maker Uno RP2040 to the

Arduino Boards Manager.

1.

2.

Open the Arduino IDE and navigate to the following directory: File > Preferences > Settings.

File Ed+ 1etch Tools Help

New Sketch

Open...
Open Recent
Sketchbook
Examples
Close

Save

Save As...
Preferences... Ctrl+Comma
Advanced

Quit Ctrl+Q BUILTIN, OUTPUT);

Scroll to the bottom of the window pane and locate the "Additional Boards Manager URLs"
box and paste this following URL:
https://github.com/earlephilhower/arduino-pico/releases/download/global /package rp
2040_index.json. Click “OK” to close the window.

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 8
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Preferences X

() Show files inside Sketches

Editor font size 14

Interface scale 3 Automatic 100 %

Theme Light v

Language English v (Reload required)

Show verbose output during [ compile (Jupload

Compiler wamnings None v

(0 Verify code after upload Paste the link here

Auto save
Editor Quick Suggestions
Additional boards manager URLs: https://github.com/earlephilhower/arduino-pico/releases/download/global/pack..

CANCEL

Note: If you already have URLs for other boards, you can separate them with commas like this:

https://github.com/earlephilhower/arduino-pico/releases/download/global /package_rp2040_index.j
son,
https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package_esp32_index.json

3. Open the Boards Manager by clicking the board manager icon or navigating to Tools >
Board > Boards Manager. Search for the word "uno rp2040," and the Raspberry Pi
Pico/RP2040 by Earle F. Philhower board package should appear, as shown in the
picture below. Click "Install” to install the board package.

File Edit Sketch Tools Help

(3 Arduino Uno

BOARDS MANAGER Blink.ino
10

uno rp20400—}e 17

’? Type: Al v 18
19
20

0 Raspberry Pi Pico/RP2040 by Earle F. Philhower, Il ---

21
Boards included in this package: Raspberry Pi Pico, Raspberry 22
Pi Pico W, 0xCB Helios, Adafruit Feather RP2040, Adafruit 23
Feather RP2040 SCORPIO, Adafruit Feather RP2040 DVI,... 24
More info 2t
- : nitialis ;
28 pinMode(LED_BUILT]
20}

4. After installation completed. Select Maker Uno RP2040 board from Tools >
Board>Raspberry Pi Pico/RP2040> Cytron Maker Uno RP2040.

Created by Cytron Technologies Sdn Bhd — All Rights Reserved 9
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0

File Edit Sketch Tools Help

uto Format

Adafruit Feather RP2040 USB Host
Adafruit Feather RP2040 CAN

Blink ino Lrchive Sketch Adafruit Feather RP2040 Prop-Maker
1 1 Jage tibrares.. Ctrl+Shift Adafruit ItsyBitsy RP2040
2 SR LT ks Adafruit Metro RP2040
3 el foles Adafruit QT Py RP2040
: Firmware Updater Adafruit STEMMA Friend RP2040
6 Upload SSL Root Certificates Adafruit Trinkey RP2040 QT
z Board: "Cytron Maker UNO RP2040" 2 Boards Manager... t t Adafruit MacroPad RP2040
; Port: "UF2_Board" » ATk o AVR Bosrds » Adafruit KB2040
1e Get Board Info Arduino Mbed OS RP2040 Boards » Arduino Nano RP2040 Connect
ii Debug Level: "None™ ® Raspberry Pi Pico/RP2040 3 » ArtronShop RP2 Nano
13 Debug Port: "Disabled” BridgeTek IDM2040-7A
i: C++ Exceptions: "Disabled” Cytron Maker Nano RP2040
16 Flash Size: "2MB (no FS)* Cytron Maker Pi RP2040
17 CPU Speed: "133 MHz" v/ Cytron Maker Uno RP2040
i IP/Bluetooth Stack: "IPv4 Only” DatanoiseTV PicoADK

20 Optimize: "Small (-Os) (standard)" Degz Robotics Suibo RP2040

RTTI: "Disabled" DeRuilab FlyBoard2040Core

Stack Protector: "Disabled” 3 DFRobot Beetle RP2040

Upload Method: "Default (UF2)" Ln 1. Col 1 L'atelier d'Aroz DudesCab

Cytron Maker

5. Next, to upload code to the Maker Uno RP2040 for the first time, you need to ensure it is in
bootloader mode. For that, firstly connect the board to your computer using a USB-C cable
and turn on the board.

Slide downward
to turn on the

Connect to

your computer

li;@

%
| I

c

6. Press and hold the “BOOT” button and then press the “RESET” button. Make sure you
release the “RESET” button first before releasing the “BOOT” button.

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 10
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2 Press RESET

I R L 1 Press & hold
i oo

| MAKER UNO RP2040 B8

B B

[ s

o

@,

7. Select the corresponding COM port by selecting Tools>Port. Now we are all set to program
and upload the code to the Maker Uno RP2040 board!

Usually, the COM port will initially appear as "UF2_Board". After the upload is successful,
the board will reset, and the COM port will then reappear as its corresponding port.

File Edit Sketch Tools Help Adafruit Feather RP2040 USB Host

Q e uto Format Ct Adafruit Feather RP2040 CAN

o s .rchive Sketch Adafruit Feather RP2040 Prop-Maker
Blink.ino 1

age Libraries... Ctrl+Shift Adafruit ItsyBitsy RP2040

Serial Monitor t t Adafruit Metro RP2040

Serial Plotter Adafruit QT Py RP2040

Firmware Updater Adafruit STEMMA Friend RP2040

Upload SSL Root Certificates Adafruit Trinkey RP2040 QT

NV B WN R

Board: "Cytron Maker UNO RP2040" Boards Manager... trl+ t+B Adafruit MacroPad RP2040
Port: "UF2_Board" Arduino AVR Boards Adafruit KB2040
Get Board Info Arduino Mbed OS RP2040 Boards Arduino Nano RP2040 Connect

Debug Level: “None™ ® Raspberry Pi Pico/RP2040 ArtronShop RP2 Nano
Debug Port: “Disabled"” BridgeTek IDM2040-7A

4

C++ Exceptions: "Disabled” Cytron Maker Nano RP2040

Flash Size: "2MB (no FS)* Cytron Maker Pi RP2040

CPU Speed: "133 MHz" Cytron Maker Uno RP2040

IP/Bluetooth Stack: "IPv4 Only" DatanoiseTV PicoADK

Optimize: "Small (-Os) (standard)" Degz Robotics Suibo RP2040
RTTI: "Disabled" DeRuilab FlyBoard2040Core

Stack Protector: "Disabled" DFRobot Beetle RP2040

Upload Method: "Default (UF2)" L'atelier d'Arnoz DudesCab

Note: You might need to recheck and reselect the COM port for the next sketch/code upload.

8. Now let’s try uploading a simple sketch. Copy the code below into the Arduino IDE. Verify
and upload the sketch by clicking by clicking the "Upload" icon in the Arduino IDE

//Turn an LED on for one second, then off for one second, repeatedly.
void setup() {

// initialize digital pin LED_BUILTIN as an output.

pinMode(1, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 11
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digitalWrite(1, HIGH); // turn the LED on (HIGH is the voltage level)
delay(1000); // wait for a second

digitalWrite(1, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

9. Ifthe code is successfully uploaded to the board, an output message as shown in the figure
below should appear, and the onboard LED1 should be blinking every one second.

Output

iff
gl

Sketch uses 52268 bytes (2%) of program storage space. Maximum is 2893856 bytes.

Global variables use 10232 bytes (3%) of dynamic memory, leaving 251912 bytes for local variables. Maximum is 262144 bytes
Converting to uf2, output size: 140288, start address: ex20e0

Scanning for RP2848 devices

Flashing D: (RPI-RP2)

Wrote 148288 bytes to D:/NEW.UF2

Ln1,Col 1 Cytron Maker UNO RP2040 on UF2 Board [notconnected] (23 B

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 12
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CIRCUITPYTHON

There are many software options you can use to program CircuitPython and MicroPython, even
simple text editors like Notepad will do the work. For this guide, Thonny IDE is chosen as the
coding software. Please download the IDE from the following link: https://thonny.org/

1. Connect the board to your laptop, power up the board and then enter bootloader mode by
pressing and holding the “BOOT” button, followed by pressing the “RESET” button.

W) Press RESET

t Pt ; Press & hold
Cygen> x ARUS ‘ BooT
MAKER UNO RP2040 s

Note: Make sure you switch on the board first before start flashing your code

Continue to hold the “BOOT” button until the RPI-RP2 drive as shown in the figure below
appeared

= RPI-RP2 (D:) X 4k

> RPI-RP2 (D) Search RPI-RP2 (D)

® New ~ Tl Sort v = View v L ses (12 Details

& Pictures » Name Date modified
® Music * ©® INDEX

naker-uno-rj # B nFo_UR2

VN
-

I Telegram Deskit
Il Screenshots
W product image

Bl DATASHEETARC
RPI-RP2 (D:) (2 items)

B c . )
B This PC Select a single file to get more
© information and share your

== RPI-RP2 (D)
(D) cloud content.
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2. The next step is to flash the CircuitPython firmware onto the board. There are two ways it
can be done;

a. Paste the CircuitPython .uf2 file to the Raspberry Pi Drive (RPI-RP2)
i. Download the latest CircuitPython firmware for the Maker Uno RP2040 board
from the CircuitPython website.

circuitpython.org,

Documentation

Clreui
p ownloads Libraries Blinka CeliStarted

Maker Uno RP2040
by Cytron Technologies

CircuitPython 9.0.0-beta.2

This is the latest development release of CircuitPython that will work with the Maker
Uno RP2040.

Alpha development releases are early releases. They are unfinished, are likely to
have bugs, and the features they provide may change. Beta releases may have
some bugs and unfinished features, but should be suitable for many uses. A Release
Candidate (rc) release is considered done and will become the next stable release,
assuming no further issues are found.

Please try alpha, beta, and rc releases if you are able. Your testing is invaluable: it
helps us uncover and find issues quickly.

Release Notes for 9.0.0-beta.2

ENGLISH (US)

“

DOWNLOAD .UF2 Now &,

Built-in modules available: _asyncio, _bleio, _pixelmap, adafruit_bus_device,
adafruit_pixelbuf, aesio, alarm, analogbufio, analogio, array, atexit, audiobusio,
audiocore, audiomixer, audiomp3, audiopwmio, binascii, bitbangio, bitmaptools,
bitops, board, builtins, builtins.pow3, busdisplay, busio, busio.SPI, busio.UART,

ii.  Drag the adafruit_circuitpython_etc.uf2 file you have downloaded to the RPI-RP2
drive.

Downloads +

& > Downloads > Search Downloads

@ New v 0 @D ® | Sort v O View v (13 Details

' Documents
i Downloads

& Pictures

@ Music

B Videos : adafruit-circuitpy
thon-cytron_mak
er_uno_rp2040-e
n_US-9.0.0-beta...

B This PC
Drag the .uf2 to this drive

RPI-RP2 (D:)

adafruit-circuitpython-
. cytron_maker_uno_rp2040-

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 14
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The RPI-RP2 drive will disappear and a new disk drive called CIRCUITPY will appear.

B This PC

&= Search This PC Q

8= View v aes (13 Details

& Pictures Devices and drives

@ Music b SN LEER(E)

343 GB free of 475 GB

¥ Videos
CIRCUITPY (D2)
AR

0.97 MB free of 0.98 MB
¥ This PC

v & CIRCUITPY (D)
m fseventsd

il b
This PC (2 items)

2 items |

b. Paste the CircuitPython .uf2 file to the Raspberry Pi Drive
i.  Open the Thonny IDE, look at the bottom right corner of the window, select
'Install CircuitPython...".

Local Python 3 « Thonny's Python =

v Local Python 3 « Thonny's Python

Install MicroPython...
2 Install CircuitPython...
Configure interpreter...
Local Python 3 « Thonny's Python =

ii.  Select the correct target volume and CircuitPython family as shown in the figure
below. Then, choose the variant as "Cytron Technologies « Maker Uno RP2040"

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 15
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T

Here you can install or update CircuitPython for devices having an UF2 bootloader
(this includes most boards meant for beginners).

1. Put your device into bootloader mode:
- some devices have to be plugged in while holding the BOOTSEL button,
- some require double-tapping the RESET button with proper rythm.

2. Wait for couple of seconds until the target volume appears.

3. Select desired variant and version.

4. Click 'Install’ and wait for some seconds until done.

5. Close the dialog and start programming!

Target volume |RPI-RP2 (D:) v
family RP2

CircuitPython family |RP2 ”a
variant m

Boardsource « Blok
Breadstick Innovations « Raspberry Breadstick
info |Ccytron Technologies « EDU PICO for Pico W
Cytron Technologies « Maker Nano RP2040 I
Cytron Technologies « Maker Pi RP2040
ytron Technologies « Maker Uno RP2040
DatanoiseTV « PicoADK - Audio Development Kit
ELECFREAKS « Picored ‘

version

Electrolama « minik Octave
Hack Club « Sprig

iii.  Click Install. You should get the output 'Done!' and a new disk drive called
CIRCUITPY will appear.

Target volume |RPI-RP2 (D:)
family RP2

CircuitPython family RP2
variant Cytron Technologies « Maker Uno RP2040
version 9.0.0-beta.2

info https://circuitpython.org/board/cytron maker uno rp2040/

: Close

() Details

a Pictures v Devices and drives

@ Vi Acer (C)

[
B Videos  » 343 GB free of 475 GB ———
CIRCUITPY
_—
o—

MB free of 0.98 MB
B This PC

CIRCUITPY (D:)
Il fseventsd

i b
This PC (2 items)
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3. Now let's try a simple code to verify that everything is working correctly. At the bottom
right corner of the window make sure the correct Configure Interferer, CircuitPython

(generic) and COM are shown and chosen.

9.0.0-beta.2 on 2024-02-20; Cytron Maker Uno RP2040 with rp2040

4. Copy this code below and paste it in your Thonny IDE.

Make sure correct COM shown

Local Pythg « Thonny's Python
v CircuitPython (generic) « CircuitPython CDC control @ COM44

Configure interpreter...

CircuitPython (generic) « CircuitPython CDC control @ COM44 =

import board
import digitalio
import time

led = digitalio.DigitallnOut(board.GP1)
led.direction = digitalio.Direction.OUTPUT

while True:
led.value = True
time.sleep(0.5)
led.value = False
time.sleep(0.5)

5. Click the Run icon to run the code.

T Thonn

File Edit View Run Tools Help

DS O e o™=

Files code.py

6. The onboard LED 1 should be blinking by 0.5 second. To stop the execution of the program,

click the STOP button or simply press CTRL+C.

T Thonny - D:\codep
File Edit View Run Tools Help
DSE O ©
Files code.py
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